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Connecting with Office
By using the Connect to Office commands, you can conveniently access commonly used libraries from a Microsoft Office program. 
[image: SharePoint sites link in the Save As dialog box]The Connect to Office commands are: Add to SharePoint sites, Remove from SharePoint sites, and Manage SharePoint sites. These commands help you conveniently interact with Office programs (Access, Excel, OneNote, Outlook, PowerPoint, Project, Publisher, Visio, and Word) and their corresponding file formats that may be stored in a library. 
For example, after you use the Add to SharePoint sites command, a shortcut to the library is created in the SharePoint Sites folder of the favorites list in the Office Save As and Open dialog boxes.
[bookmark: _Toc273086540][bookmark: _Toc296248175]Add, remove, or manage SharePoint sites for Office programs 
First, you do need to visit a SharePoint site to open a library - but only once to set things up. Once you’ve identified the library where you want to post or access your content, you simply select it, click the Library tab under Library Tools, and click the Connect to Office command in the Connect and Export group on the ribbon.
[image: ]

Select Add to SharePoint Sites and you’re done.
[image: addtospsites.gif][image: ]

This command adds the library path to the SharePoint Sites folder that appears when you use the File ->Open or Save As commands in an Office application. This folder also appears in your Windows Explorer Favorites list. 
Using the Add to SharePoint Sites command on a library lets you do the following tasks easily:
· Open a SharePoint library document from your Office application and update it.
· Share or publish a new document directly from your favorite Office application to a SharePoint site library.
· Insert images, videos, and audio files from a SharePoint Asset Library into Office documents. ​
· Find a connected SharePoint library document in your Windows Explorer file system.
Try the following approaches to see how easy it is to get your documents into or out of a SharePoint site without leaving an Office app. 
First, connect the library to Office:
1. Open a SharePoint site library from the browser.
2. Click the Library tab. 
3. Click the Connect to Office command in the ribbon and select Add to SharePoint Sites. 
Repeat this process any time you want to add another library link to the SharePoint Sites folder in your file system. After you’ve connected a SharePoint library to Office, you can work on a SharePoint library document from Office or save a new Office document to the SharePoint library. 
To open and edit a SharePoint library document from an Office application:
1. After you’ve connected a SharePoint library to Office, as described above, start an Office application, such as Word.
2. Click the File tab and then click Open.
3. Select SharePoint Sites from the Favorites list.
[image: ]
4. Select the desired library from the sites list, such as Shared Documents in this example. Notice that the site name, Contoso Team 2011 in this case, precedes the library name.
5. Choose a document, such as Contoso 2011 marketing plan in this example. 
[image: ]
6. Double-click the document to open it in your Office application.
7. Edit and save the document as you would any other Office document.
The document will save to the SharePoint site library by default.
8. If you want to confirm, go to the SharePoint site library from your browser and open the document to see your updates.
When you open the document in the future, it will reflect any changes that other team members may have made.
[bookmark: _Toc296248176]To create a document in an Office application and easily upload it to a SharePoint library:
1. After you’ve connected a SharePoint library to Office, as described at the top of this post, start your Office application, such as Excel, and click New to create a new document. For instance, start Word and create a new spreadsheet.
2. Enter a title, such as Metrics, and add some content.
3. From the Office application, click File ->Save As, and then click SharePoint Sites from the Favorites list. 
[image: ]
4. Select the library you need, such as Shared Documents, preceded by the site name, which is Contoso Team 2011 in this example. Your new document will be saved to the selected library.
When you access the document again, it will reflect any updates that others may have made since you last saw it.
5. If you want to confirm the upload, go the SharePoint site library from the browser to see the new Metrics document.
[image: ]
[bookmark: _Toc296248177]To easily insert images and videos from a SharePoint Asset Library into an Office document: 
1. Identify the SharePoint Asset Library that contains the assets you want to add to a document.
2. After you’ve connected a SharePoint library to Office, as described above, start an Office application, such as Word.
3. Click the File tab and then click Open.
4. Select SharePoint Sites from the Favorites list.
5. Identify the Asset Library in the sites list and click it to display its contents. 
When the contents page opens, you can see the assets that you need, conveniently accessible to your Office document.
6. Copy the image, video, or other asset that you want and paste it into your document.
7. Edit and save your document as you normally would.
[bookmark: _Toc296248178]To find a connected SharePoint library document in your file system:
1. Open Windows Explorer.
2. Click the SharePoint Sites item at the bottom of the Favorites list to see connected library paths.
[image: Capture4a.GIF][image: ]
3. Click the link to the appropriate library.
4. Double-click the document you want to open it in its native Office application, such as Word, Excel, or PowerPoint.
Tips:
· When you need to access another site library, use the Add to SharePoint Sites command again, as described at the top of this post. Just remember, one connection – one library.
· You can make a library-to-Office connection at any time, even while a document is open in your Office application is open. As long as you use the Add to SharePoint Sites command before trying to connect to the library, you’ll be fine. 
· If you have trouble accessing or editing a site library document, make sure you have the necessary SharePoint site permissions, the same as you would need if you were working in the site from a browser.
· If you made a connection in error, you can remove it by using the same Connect to Office command described above. But select Remove from SharePoint Sites instead of the Add option.
[image: ]

[bookmark: _Toc296248179]Synchronizing with Outlook
[bookmark: _Toc204662450][bookmark: _Toc215398451][bookmark: _Toc262734693]You can synchronize a SharePoint library, contact list, task list, Project task list and a certain type of SharePoint external list with Microsoft Outlook 2010. Because many SharePoint 2010 users also use Outlook 2010 to collaborate and coordinate activities and projects, the ability to synchronize these libraries and lists can help you become more efficient, especially if you work offline or don’t have convenient access to your SharePoint sites all the time. To synchronize these libraries and lists, you must have Outlook 2010 installed on your client computer and you must have Collaborate permission to the library or list.
[bookmark: _Toc296248180]Working with a synchronized document library
You can synchronize a SharePoint library between Outlook 2010 and SharePoint 2010. Once you synchronize a library, the library appears as a folder in the Outlook Navigation Pane under SharePoint Lists. 
When you use Instant Search, Outlook searches all the synchronized SharePoint documents. Document previews in the Outlook Reading Pane enable you to easily browse through search results. You may find opening and saving changes to SharePoint documents from Outlook faster and more convenient. You can then preview, edit, and manage documents in the SharePoint library from within Outlook. You can also take the libraries offline, work with the Office files in the library, bring them back online, and then synchronize the changes.
This synchronization is one-way or unidirectional for Office files. Changes made to files in the SharePoint library can be downloaded to Outlook, but you cannot make changes to non-Office files in Outlook and upload them back to the SharePoint library. If you work with Outlook offline, you can edit Office files, such as Word documents, Excel spreadsheets, and PowerPoint presentations. When you come back online, you can upload your changes to the SharePoint library. However, Outlook does not track changes made to these Office files made in the SharePoint library. For best results, check out these files first, if you intend to make offline changes to them in Outlook.
[bookmark: _Toc262734695][bookmark: _Toc296248181]Working with a synchronized contact list
You can synchronize a SharePoint contact list between Outlook 2010 and SharePoint 2010. This enables you to store, share, and manage SharePoint contacts more efficiently in Outlook. You can also take the contact list offline, work with the contacts, bring them back online, and then synchronize them either from Outlook 2010 or SharePoint 2010.
From Outlook 2010, the synchronized SharePoint contact list works just like other Outlook contact folders. You can view, edit, print, and even call these contacts by using Microsoft Office Communicator. You can send them e-mail messages and meeting requests, use color categories, store multiple phone numbers and e-mail addresses, and include contact photos, Electronic Business Cards, as well as birthday and anniversary information. 
This contact list synchronization is two-way or bi-directional. Changes made in Outlook to these contacts are automatically synchronized with the SharePoint Contact list. Changes made to the SharePoint Contact list are automatically synchronized with the contacts in Outlook. 
When you open a SharePoint contact in Outlook or open the Contact list in SharePoint 2010, you see the latest changes. If changes are made to the contact in Outlook while the SharePoint Contact list is opened, you must refresh the browser to see the latest changes in the SharePoint list. If changes are made to the SharePoint Contact list while the contact is opened in Outlook, you must use the Send/Receive command to see the latest changes in the Outlook contact.
[bookmark: _Toc262734696][bookmark: _Toc296248182]Working with a synchronized task list
You can synchronize a SharePoint task list between Outlook 2010 and SharePoint 2010. You can work with both a standard task list and project task list, which is similar to a standard tasks list, except that a project tasks list provides a graphical display of the task items, called a Gantt view. You can also take a task list offline, work with the tasks in the list, bring them back online, and then synchronize them from Outlook.
The contents of the synchronized task list appear under Other Tasks in the Navigation Pane and consolidated in the To-Do Bar. To track the status, progress, and history of your projects, you and team members can create, assign, update, respond to, and delete tasks when working in your respective Outlook folders. 
You can also apply flags and categories to your synchronized tasks as you do with your Outlook tasks. The flags and categories do not appear on the SharePoint site, but the flags and categories are available when you work with your synchronized tasks in Outlook. SharePoint task notifications are also fully integrated with tasks and calendars, and you can choose settings to automatically generate notification e-mail messages and reminders.
This task list synchronization is two-way or bi-directional. Changes made in Outlook to these tasks are automatically synchronized with the SharePoint Task list or Project Task list. Changes made to the SharePoint Task list or Project Task list are automatically synchronized with the tasks in Outlook. When you open the task in Outlook, or open the SharePoint Task list or Project Task list in SharePoint 2010, you see the latest changes.
If changes are made to the task in Outlook while the SharePoint Task list is opened, you must refresh the browser to see the latest changes in the list. If changes are made to the SharePoint Task list while the task is opened in Outlook, you must use the Send/Receive command to see the latest changes in the Outlook task.
[bookmark: _Toc262734697][bookmark: _Toc296248183]Working with a synchronized external list
You can synchronize a SharePoint external list between Outlook 2010 and SharePoint 2010. A SharePoint external list is created by using Business Connectivity Services (BCS) in SharePoint Designer 2010, and can contain read/write access to Line-of-Business data from data sources, such as SQL Server or SAP. 
When you create an external content type in SharePoint Designer 2010, you can map it to a native Office item type such as a contact or task so that the external data looks and behaves just like a contact or task item in Outlook. For example, suppose that your external data is a list of customers and you want to display that external data in Outlook. Because the data for customers closely resembles contacts in Outlook, you can map that external content type to the contact item in Outlook. After you connect the external list to Outlook by using the Connect to Outlook command, you can create, update, and delete the external data directly from Outlook just as you would create and update your Outlook contacts and tasks.
[bookmark: _Toc262734698][bookmark: _Toc296248184]Additional integration points
Outlook 2010 has additional integration points with SharePoint 2010 including the following:
· Participate in online discussions by using e-mail messages
· Display SharePoint 2010 and Outlook 2010 calendars side-by-side
· Manage SharePoint alerts and RSS Feeds
· Create a meeting workspace
· Use Outlook Web Parts in SharePoint 2010 to, for example, display Outlook messages
· Use The Outlook Social Connector add-in to manage social feeds from your colleagues.
Find more information about these additional integration points in the Outlook 2010 and SharePoint Help systems.
[bookmark: _Toc262734699][bookmark: _Toc296248185]Synchronize a SharePoint library with Outlook 2010
1. In your browser, navigate to the SharePoint site containing the library that you want to synchronize.
2. Click the name of the library on the Quick Launch, or click Site Actions, click View All Site Content, and then in the appropriate library section, click the name of the library.
3. In the ribbon, on the Library tab, in the Connect & Export group, click Connect to Outlook.
4. When prompted to open a program on your computer, click Allow. 
5. If you are prompted to confirm the operation, click Yes.
In Outlook, the library is added to the Navigation Pane under SharePoint Lists. The files in the library behave similar to e-mail messages. For Office files, click to preview the file in the Reading Pane or double-click the file to open it. Right-click the file for more options.
Notes 
· If the library has subfolders and you want to have access to all of the files in Outlook, view the library at its top level and then connect it to Outlook. By default, if you are in a subfolder of a library, and then connect the library to Outlook, only the contents of that folder are connected. 
· To access only the contents of a single folder in Outlook, there are two options. If the folder that contains files that you want to access in Outlook is not open, point to the folder, click the Open Menu arrow that appears, and then click Connect to Outlook. If the folder that you want to connect is already open, follow the steps to connect a library. 
· After you connect a library to Outlook, you can invite other team members to connect to the library. Right-click the library name in Outlook, and then click Share This Folder. 
[bookmark: _Toc262734700][bookmark: _Toc296248186]Synchronize a SharePoint contact list with Outlook 2010 contacts
1. In your browser, navigate to the SharePoint site containing the contact list that you want to synchronize.
2. Click the name of the contact list on the Quick Launch, or click Site Actions, click View All Site Content, and then in the appropriate list section, click the name of the contact list.
3. In the ribbon, on the List tab, in the Connect & Export group, click Open in Outlook.
4. When prompted to connect the SharePoint contacts to Outlook, click OK. 
In Outlook 2010, the contacts are added under Contacts in the Navigation Pane.
[bookmark: _Toc262734701][bookmark: _Toc296248187]Synchronize a SharePoint task list with Outlook 2010 tasks
1. In your browser, navigate to the SharePoint site containing the Task list or Project task list you want to synchronize.
2. Click the name of the task or project task list on the Quick Launch, or click Site Actions, click View All Site Content, and then in the appropriate list section, click the name of the task or project list.
3. In the ribbon, on the List tab, in the Connect & Export group, click Open in Outlook.
4. When prompted to connect the SharePoint Contacts list to Outlook, click OK. In Outlook 2010, the tasks are added under Other Tasks in the Navigation Pane, and in the To-Do Bar.
Note You can work with your tasks from your SharePoint site similar to the way you work with your Outlook tasks. You can drag or copy tasks back and forth between the folders for Outlook and the SharePoint site. However, recurring tasks and task requests from Outlook are converted to regular tasks on the SharePoint site.
Tip After you connect a Task list or Project Task list to Outlook, you can send a sharing message to other team members that invite them to connect to the tasks. Right-click the list name in Outlook, and then click Share tasks list name. This creates an e-mail message that contains a link and a command to connect to the list.
[bookmark: _Toc296248188]Synchronizing with Excel
You can synchronize data between a SharePoint list and a spreadsheet program, and keep both sets of data up-to-date. For example you may want to maintain a product inventory in a SharePoint list so that it’s easy to share and update, but also do periodic inventory analysis by using a spreadsheet program, such as Microsoft Excel 2010.
[bookmark: _Toc263247002]There are three ways to synchronize data between a SharePoint list and a spreadsheet program. Whichever way you choose, this synchronization is one-way, or unidirectional. Changes made in the SharePoint list can be updated in the spreadsheet program, but any changes that you make in the spreadsheet program are not written to the SharePoint list.
[bookmark: _Toc263247003][bookmark: _Toc296248189]Synchronizing list data by using the Export to Spreadsheet command
You can synchronize the data in a SharePoint list with a compatible spreadsheet program by using the Export to Spreadsheet command in the list ribbon. As the SharePoint list continues to be updated, depending on your spreadsheet program, you can also use a command in your spreadsheet program to manually update your spreadsheet with the latest data. 
For example in Excel 2010, you can refresh the data connection, which replaces and overwrites the Excel data with the current list data. If your SharePoint list contains folders, the folder structure does not appear in the resulting Excel table. However, the Item Type and Path columns are added to the Excel table so you can filter and sort the data, based on its type and location or subfolder of the list.
[bookmark: _Toc263247004][bookmark: _Toc296248190]Synchronizing list data by using the Query List with Excel command in Datasheet view
If you have Excel 2010 installed on your client computer, you can also synchronize a SharePoint list from Datasheet view by using the Query List with Excel command available in the Datasheet view task pane. Using additional commands in the task pane, you can also synchronize the list data and do the following:
· Create an Excel chart
· Create an Excel PivotTable
· Print the list from Excel
[bookmark: _Toc263247005][bookmark: _Toc296248191]Synchronizing list data by using the Export Table command in Excel
From Excel 2010, you can also export an existing Excel table to a new SharePoint List by using the Export Table to SharePoint List Wizard. This approach is useful when you already have the data in an Excel table and you want to create a SharePoint list during the synchronization process. 
[bookmark: _Toc263247006][bookmark: _Toc296248192]Synchronize a SharePoint list with a spreadsheet program
1. Navigate to the SharePoint site that contains the list you want to synchronize with a spreadsheet program.
2. Click the name of the SharePoint list on the Quick Launch, or click Site Actions, click View All Site Content, and then in the appropriate list section, click the name of the list.
3. On the ribbon, click the List tab, and then in the Connect & Export group, click Export to Spreadsheet. 
4. If you are prompted to confirm the operation, click OK. 
5. In the File Download dialog box, click Open. 
6. If you are prompted whether to enable data connections on your computer, click Enable if you believe the connection to the data on the SharePoint site is safe to enable. Excel creates an Excel Table with a data connection based on a Web query file. 
To see further changes made to the SharePoint list in spreadsheet program, you must manually update the data. For example in Excel 2010, in the Excel table connected to a SharePoint list, on the Design tab, in the External Table Data group, click Refresh.


[bookmark: _Toc296248193]SharePoint Workspaces
Using Microsoft SharePoint Workspace 2010, you can work with SharePoint 2010 sites, libraries, and lists on your desktop computer or laptop, whether in or out of the office. Synchronization of changes between your computer and the SharePoint server are handled in a smooth and efficient manner. Using SharePoint Workspace 2010 can help save you time and help manage your collaboration efforts much more effectively. 
When you are connected, synchronization can occur automatically behind the scenes, although you can make the changes manual if you want. When you are not connected —at home, on the road, or in the air — you can continue to work on your computer. When you come back online, SharePoint Workspace 2010 synchronizes changes you and others made while you were offline. 
For example, you can edit documents, presentations, files, and lists (both native and external) on your computer while offline on a business flight. You can do this by using your standard Office products and features, such as Office Word 2010, Office Excel 2010, and Office InfoPath 2010. When you come back online to your SharePoint 2010 sites, all the changes can be synchronized automatically, and any conflicts resolved smoothly.
To synchronize a SharePoint site, library, or list, you must have SharePoint Workspace 2010 installed on your client computer and you must have Contribute permission to the site, library, or list.
[bookmark: _Toc263166748]What is Synchronization?
In short, synchronization means that any changes made on your computer or the SharePoint server are continually reconciled so that the content is the same on both computers. This synchronization is two-way or bi-directional. Changes made on your computer are uploaded to the server, and changes made on the server are downloaded to your computer. SharePoint Workspace 2010 synchronization is also efficient; only the changes to a file or list are synchronized, not the entire file or list.
[bookmark: _Toc263166749][bookmark: _Toc296248194]Working with documents in SharePoint libraries
You can work with files in SharePoint libraries on your computer by using SharePoint Workspace 2010. The library view in SharePoint Workspace 2010 is very similar to the view in SharePoint 2010. Custom columns, views, and content types are supported. This includes library views, both public and private.
Custom properties, such as title, priority, and keyword, show up in Word, Excel, and PowerPoint Document Information Panels. Even the New command with any defined content types works in a similar manner.
You can also open and save Office files, such as documents, spreadsheets, and presentations, from and to your local workspaces by using the familiar Office Open and Save dialog boxes. You can even drag and drop files from Windows Explorer to your SharePoint workspace. 
Checking in, checking out, and creating major and minor versions is also supported. Related commands are enabled on the SharePoint Workspace ribbon when you are online, but unavailable when you are working offline.
Note that an Office file, such as a Word document or PowerPoint presentation, is treated by SharePoint Workspace 2010 the same way that it would treat a file opened directly from the browser, and even maintains the URL, which you can view and copy in Backstage view.
[bookmark: _Toc263166750][bookmark: _Toc296248195]Working with list data
You can work with SharePoint lists, both native and external, on your computer by using SharePoint Workspace 2010. Most types of columns, metadata, and content types are also supported in SharePoint Workspace 2010. This includes list views, both public and private.
If an occasional conflict occurs when two or more people edit the same list item, then you can use the conflict resolution dialog box to resolve the conflict and be on your way. Even when list metadata changes on the server, the new list metadata can be synchronized on your computer. For example if a calculated column is added on SharePoint 2010, then SharePoint Workspace 2010 picks up the change the next time synchronization occurs.
External lists, created by using Business Connectivity Services (BCS) in SharePoint Designer 2010 are also supported. External lists can contain read/write access to Line-of-Business data from data sources, such as SQL Server or SAP. This means that you can work with your external list data from within SharePoint Workspace 2010, whether online or offline, and smoothly synchronize your changes directly to the external data source.
You’ll find it easier and faster to add and edit list item data and metadata on your computer in a SharePoint Workspace 2010 than in a browser on a SharePoint site. You can view the list data in a grid-like view, and edit the data in a form. The split form feature gives you a unique and practical view into your data. 
If an InfoPath form designer has associated an InfoPath 2010 form with the list, you can synchronize that form and use it in your SharePoint Workspace 2010. This means you can take advantage of InfoPath’s form features such as spell checking, file attachments, rich text, field validation, and business rules.
[bookmark: _Toc263166751][bookmark: _Toc296248196]Searching SharePoint Workspace 2010 content
Searching SharePoint Workspace 2010 content works in a smart and robust way:
· When you search in a workspace or from the Launchbar, you can find content across all your site workspaces. 
· When you search from the Microsoft Windows 7 Start button, you search across your desktop and all your downloaded content from SharePoint Workspace 2010. Workspaces are automatically indexed. Local search is fast and works whether you are offline or online.
[bookmark: _Toc263166752][bookmark: _Toc296248197]Limits, exceptions, and workarounds
There are certain limits and exceptions when working with SharePoint 2010 content with SharePoint Workspace 2010. Note that the navigation pane of the SharePoint Workspace 2010 displays links to unsupported lists and libraries, which you can conveniently click to work with in SharePoint 2010 for full support if you are online.
Be aware of the following limits and exceptions when working in SharePoint Workspace 2010:
· Each SharePoint workspace that you create on your computer is limited to 2 Gigabytes and a total of approximately 500 files. 
· The total number of files you can store in all your SharePoint workspaces is 1800. 
· Each list can have no more than 30,000 items.
· From within SharePoint Workspace 2010, you can create, update, and delete files in a library and new items in a list, but you cannot create new sites, libraries, and lists.
· Sites based on an Access Web Database template are unsupported.
· The following lists are unsupported: Calendar, Wiki page, and Survey.
· The following views are unsupported: Project Task list in Gantt view, Style, In-line Folders (which show as groups), and Item Limit.
· The people picker control is not supported.
· The editing of site pages in the site pages library is not supported.
· The editing of list attachments is not supported (Although you can open the attachment as read-only).
· The synchronization of changes made to a OneNote notebook is not supported. 
· Lists or libraries protected by Information Rights Management (IRM) are not supported.
[bookmark: _Toc263166753][bookmark: _Toc296248198]Synchronize a SharePoint workspace with a SharePoint site
1. In your browser, navigate to the SharePoint site you want to synchronize.
2. Click the Site Actions menu, and then click Sync to SharePoint Workspace.
3. To selectively control which libraries and lists are downloaded:
1. Click Configure.
2. For each list or library, select it, and then in the Download box, select Headers Only (libraries only) or No Content. You can download the full content later on if you need to.
The first time you synchronize an entire site, it may take a few minutes to download all the files on your computer, but this occurs behind the scenes, so you can continue to work on other tasks.
Note If the site contains subsites, these are not downloaded, but you could download those separately if you need to.
[bookmark: _Toc263166754][bookmark: _Toc296248199]Synchronize a SharePoint workspace with a specific library or list
You can select a specific library or list, if that's all you need to work with from a site. You might want to be selective about what you download to save space on your personal computer or because you do not have permission to synchronize the rest of the site. 
1. In your browser, navigate to the SharePoint site containing the list or library you want to synchronize.
2. Click the name of the list or library on the Quick Launch, or click Site Actions, click View All Site Content, and then in the appropriate list or library section, click the name of the list or library.
Note A SharePoint site can be significantly modified in appearance and navigation. If you cannot locate an option, such as a command, button, or link, contact your administrator.
3. In the ribbon, on the List or Library tab, in the Connect & Export group, click Sync to SharePoint Workspace.
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